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1 
Introducing RoboCell 

RoboCell is a software package that integrates four components: 

 SCORBASE, a full-featured robotics control software package, which 
provides a user-friendly tool for robot programming and operation. 

 A Graphic Display module that provides 3D simulation of the robot and 
other devices in a virtual workcell. 

 CellSetup, which allows a user to create a new virtual robotic workcell, 
or modify an existing workcell. 

 3D Simulation Software Demo to demonstrate RoboCell’s capabilities. 

This manual covers all features and operation of the Graphic Display and 
CellSetup modules.  

SCORBASE menus and commands are described in the SCORBASE User 
Manual. 
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2 
Starting RoboCell 

System Requirements 

For best performance, the following system is recommended: 

 Computer: Pentium 4 Dual Core with 3 GHz processor or higher, 
equipped with CD drive  

 At least 512 MB RAM  

 A hard drive with at least 100 MB of free disk space  

 Windows XP/Vista/7. 

 A VGA or better graphics display, minimum 256 colors  

 A mouse or other pointing device. 

 USB port 

Minimum requirements are:  

 Pentium 4 Dual Core with 2 GHz processor  

 512 MB  

 
Note: The system must also meet the operating system's requirements in 
order to function correctly. 

Software Licensing 

The RoboCell software is protected by a licensing agreement. Full details 
on Intelitek software licensing are provided in Chapter 10. 



Installing the Software 

The RoboCell software is supplied on a CD which also contains 
SCORBASE. Close any applications that are open before proceeding with 
the installation procedures. If you are about to reinstall the software, or 
install a newer version to an existing RoboCell directory, it is 
recommended that you back up any existing user-created files before you 
begin the installation.  

It is also recommended that you remove the previous RoboCell version for 
Windows installation using the software's Uninstall utility (see Uninstall in 
this section, page 6). 

To install RoboCell: 

1. Insert the CD into the CD-ROM drive to start the installation 
procedure. 

2. If the procedure does not start, either: 

3. From the Windows task bar, click Start | Run and type D:Setup 
(where D: is your CD drive), 

or 

Using Windows Explorer, explore the CD drive and 

click  Setup. The ScorbasePro - InstallShield Wizard is displayed. 
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4. Click Next. The License Agreement is displayed. 

 

5. Review the Intelitek software license agreement. You must accept the 
terms of this agreement in order to proceed with the installation. Click 
I accept and Next to continue. The Setup Type window is displayed. . 

 

6. Select RoboCell for SCORBOT-ER 9Pro and click Next. 
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RoboCell Utilities 

These utilities are available from the RoboCell group: 

 Robocell-Pro:  

 CellSetup 

 3D Simulation Software Demos 

 Uninstall 

3D Simulation Software Demos 

Demonstration files included with the software allow you to observe the 
capabilities of RoboCell. To run these demo files, do the following: 

1. Activate the demos by selecting Start | Programs | RoboCell | 
3DSimulation Software Demos. The default demo opens and starts 
automatically. 

2. To view another demo file, select File | Open, or click on the Open 
icon. 

3. Select the desired *.DMO file from those listed in the Open window. 
The program starts automatically. 

4. To stop a demo, select File | Stop. 

5. Use the Menu options or Toolbar icons to navigate in the virtual cell. 
See Chapter 4, CellSetup, on page 11 for full details. 

6. To exit the Demos utility, select File | Exit.  

Uninstall 

To uninstall RoboCell, do the following: 

1. From the RoboCell program group, select Uninstall. 

2. Follow the instructions which appear on the screen.  

Chapter 10, Intelitek Software Licensing, provides full details on the 
procedures for protecting your license, transferring the license to another 
PC, and returning the license to Intelitek for retrieval at a later stage. 

Quitting the Software 

To close RoboCell (or its components), do any of the following: 

 From the Menu Bar, select File | Exit. 

 Click the Close box in the SCORBASE Title Bar. 



 

3 
Graphic Interface 
The 3D image you see on your screen is the output of a virtual video 
camera fitted in the workcell. You can use the mouse to manipulate the 
image. 

The Graphic Display and CellSetup in RoboCell have the same graphic 
interface. 

Rotate 

To rotate the scene (move the camera around the center of the image): 

 Place the cursor anywhere in the graphic window and click the right 
mouse button. The cursor changes to a magnifying glass. 

 Keep the right mouse button depressed and drag to the right to rotate the 
scene counterclockwise. 

 Similarly, keep the right mouse button depressed and drag to the left to 
rotate the scene clockwise. 

 

Figure 3-1: Rotating the Scene 

The image rotates around its center point. To change the center point, use 
the Redirect Camera tool (see 15).  on page View Menu
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Zoom 

To zoom in or out: 

 Place the cursor anywhere in the graphic window and click the right 
mouse button. The cursor changes to a magnifying glass. 

 Drag up to zoom in. 

 Drag down to zoom out. 

 

Figure 3-2: Zooming with Camera 

The image zooms in and out while its center point remains fixed. To 
change the center point, use the Redirect Camera tool (see View Menu , on 
page 15). 
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Angle 

To change the angle of the overhead scene (to move the camera up or 
down), use the mouse wheel or place the cursor on the vertical scroll bar 
and drag it up or down. 

 

Figure 3-3: Changing Camera Angle 

The camera moves up or down while the center point of the image remains 
fixed. To change the center point, use the Redirect Camera tool (see View 
Menu, on page 15). 

Brightness 

To change cell illumination (bright or dark), click the right mouse button 
and drag in any direction, while holding down [Ctrl]. The cursor changes 
to a light bulb. 
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4 
CellSetup 

CellSetup allows you to create a new virtual workcell, or modify an 
existing one. A workcell created using CellSetup can be theoretical or a 
replica of actual robotic installations. 

After creating a workcell, you can open it in RoboCell, where you can 
define positions, write programs and run them. If a controller and a robot 
are connected to your computer, you can switch RoboCell to On-Line, and 
run the virtual robot in the virtual cell, together with the real robot in the 
real cell. 

Opening CellSetup 

To open CellSetup: 

1. Select Start | Programs | RoboCell | CellSetup. After initialization, the 
following screen appears: 

 

Figure 4-1: CellSetup Opening Screen 

2. Select File | New to create a new workcell. 

 If you want to open an existing workcell, select File | Open from the 
Opening Screen. For further details, see File Menu below. 
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 If you are working in RoboCell and you want to modify the current 
workcell you are using, select File | Edit 3D Model. CellSetup opens with 
your current workcell. At this point, you cannot open another cell, 
therefore the New and Open options are not available. When you exit 
CellSetup after having completed your modifications, you will return to 
RoboCell where the newly edited cell will be displayed. For further 
information, see Chapter 5, Working in RoboCell, on page 43. 

CellSetup Window 

Figure 4-2 shows an existing workcell in the CellSetup window. The 
window comprises: 

 A Menu Bar containing all command menus and options. 

 A Toolbar containing icons for the most commonly used options. 

 Working area containing the workcell objects. 

 A Status Bar displaying RoboCell status messages. 

 
 
       

      Menu Bar 
       Toolbar 

 

 

 
 Working Area 

 

 
 

  
  
      

 

 

 

 

               Status Bar 
Figure 4-2: CellSetup Window 
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File Menu 

 

Cell data is stored in a *.3DC file. The File menu contains the 
usual Windows functions that allow you to load and save 
3DC files, and to exit the software. 

In addition, you can open the most-recently opened workcell 
files from this menu. 

Note: Only one workcell file can be opened at a time. 

 

   

 

New Opens a new, untitled, CellSetup file, and opens 
the New Object menu. 

This icon and menu option are available only if 
CellSetup is opened from the Programs menu. 

 
Open The Open dialog box appears. You can open an 

existing CellSetup file (e.g., robo1.3DC). The cell 
defined in the file is displayed and the New 
Objects menu opens. 

This icon and menu option are available only if 
CellSetup is opened from the Programs menu. 

 
Save Saves the current placement of all objects in the 

cell to a CellSetup file. Default file extension is 
3DC. 

 Save As… Saves the currently active CellSetup file under a 
new file name. 

Note: Peripheral axes are redefined (through the 
robot’s properties menu) in the new file created 
by the Save As operation. 

 Print 3D 
Image 

Prints the currently displayed 3D image. 

 Print Preview 
3D Image 

Opens a dialog window that shows how the 
printed cell will appear on paper. 

 Exit Closes CellSetup. 
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Edit Menu 

 

The Edit menu contains functions that allow you to add new objects, 
delete and relocate objects and drag them (change their position in the 
cell). Through this menu you can also set the floor size and cell textures. 

 

   

 

New Object Opens/closes the New Object menu. From this 
menu you can select objects to add to the cell. For 
detailed information, see New Objects Menu, on 
page 21. 

 

Delete Object Activates the delete mode in order to delete an 
object from the cell. 

Using the cursor, point and click on the object you 
want to delete. Click Yes to confirm the deletion. 
If you click No, the delete mode remains in effect, 
allowing you to select and delete another object. 

Press [Esc] to cancel the delete mode. 

 

Drag Object Activates the drag mode in order to relocate an 
object in the cell. 

Using the cursor, point and click on the object you 
want to relocate and drag it to its new position. 
The drag mode remains in effect until you select 
another option or press [Esc]. 

Floor Size Opens the Set Floor Size dialog box where you 
can set the X and Y dimensions of the cell. Click 
OK to confirm the new size or Cancel to close the 
dialog box. 

Set Texture Opens a sub-menu listing cell textures: floor, land 
and background. Select the desired .bmp file for 
the specified texture. 
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View Menu 

 

The View menu enables control of the position and name labels, 
and the virtual camera position. Through this menu you can toggle the 
display of the Toolbar and Status Bar.  

 

Controller Setup The robot controller has eight digital input and 
eight digital output connections. Certain objects 
that are placed in the cell have a predefined 
number of input and/or output positions at which 
they can be connected to the controller. For 
further information, see the section describing 
each specific object in New Objects Menu, on 
page 21. 

In addition, peripheral devices can be connected 
to axes 7 and 8 of the controller (see Robot 
Configuration, on page 21 and 

Peripheral Axes, on page 24). 

Through the Controller Setup dialog box (see 
Figure 4-3) you can view the defined objects 
and modify their input, output and axes 
connections under the appropriate tab. 

 

Figure 4-3: Controller Setup 

Devices that have not yet been connected are 
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listed under Not connected. 

To connect a non-connected device, click on the 
device and drag it to a free input/output/axis.  A 
plus (+) sign appears next to the cursor. 

To modify an existing connection, drag the 
input/output/peripheral to a new setting. A swap 
sign appears next to the cursor. If you drag the 
device to a setting that already has a connected 
device, the new device replaces the previous 
device which is disconnected and relocated 
under Not connected. 

To disconnect input/output/peripheral, drag the 
object to the Not connected list. A minus (-) sign 
appears next to the cursor. 

 
Show Names  Shows/hides the Object Name labels (see Figure 

4-4). When you select this option, a label on 
each object shows its name. Names are assigned 
by the software but can be renamed by the user 
in the object’s properties menu. 

This option cannot be selected together with 
Show Positions. 

Figure 4-4: Show Object Names 

 
Show Positions Shows/hides the Object Position labels (see 

Figure 4-5). When you select this option, a label 
on each object shows its position. The 
coordinates that appear on the object’s label 
indicate the object’s position (X, Y coordinates) 
relative to the cell’s point of origin. 

 

This option cannot be selected together with 
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Show Names. 

 

Figure 4-5: Show Object Positions 

 
Redirect Camera Allows you to select a different focal point in 

the graphic display of the cell. 

To change the center point of the graphic 
display window, click on the icon or menu 
option. Use the cursor to point and click on any 
spot in the scene. This now becomes the new 
center point of the display. All zooming of the 
view will focus on this point; all rotations will 
revolve around this point. 

Press [Esc] to cancel the Redirect Camera mode. 

 

Drag 3D Frame Activates the drag mode in order to relocate the 
entire cell in a new position. Click anywhere in 
the image and drag the entire cell to a new 
position. 

The drag mode remains in effect until you select 
another option or press [Esc]. 

 

Camera Top Resets camera position to display an overhead 
view of the cell. You can rotate or zoom in/out 
of this view. Use the vertical scroll bar to alter 
the angle of the view. 

 Scene Origin Shows the origin of the cell at floor level (under 
the center of the robot’s base) as a red cross 
marked with X and Y axes. The positions of all 
objects are defined as relative to this point of 
origin. 

 

When manipulating the graphic display, the 
cross may disappear momentarily. Rotating the 

RoboCell User Manual 17 CellSetup 
1103   



RoboCell User Manual 18 CellSetup 
1103        

view does not change the X and Y dimensions 
of the cell. 

Toolbar Shows/hides the Toolbar. 

Status Bar Shows/hides the Status bar. 

Help Menu 

RoboCell Help Opens RoboCell on-line help. 

About Shows the RoboCell software version. 

Registration Opens the Software License Window for 
registration, and for transferring RoboCell license 
to another computer. (See Intelitek Software 
Licensing, on page 79 for further information.) 

Objects 

Object Placement 

To place a new object in the cell, do the following: 

1. Double click on the object’s name in the New Objects menu. 

2. Move the cursor into the graphic scene. 

3. Point and click on the location where you want to place the object. 
You may need to wait a moment for it to appear; do not double click. 

If you have trouble placing an object in the exact spot you want, zoom in 
and out, and adjust the view from top to bottom until you can more 
accurately place the object. 

Most objects are placed in the cell automatically at table level. These 
objects will appear to float in space unless a table has also been placed in 
the cell. 

The height of some objects (template, jig, cylinder and cube) is determined 
at the time they are placed in the cell. 

If, for example, you click on the conveyor when placing a cube in the 
scene, the cube will be placed on the conveyor at the proper height. 

It is recommended that a table be placed in the cell before any of these 
four objects is added to the cell. Otherwise, these objects may be set on the 
cell floor and are hidden when a table is added. 
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Once an object’s height is set, it cannot be changed in CellSetup. For 
example, you cannot move the cube from the table onto the conveyor. 
Moving an object whose height has been set will cause it to float in space 
or penetrate another object. If the setup is saved with a floating object, the 
object will fall to the surface below it when the file is loaded in RoboCell. 

To change an object’s height in CellSetup, you must delete the object and 
create a new one. 

To move an object, simply click on it and drag it to another position. Or 
use the object’s properties menu to set precise position coordinates. 

The robot cannot be dragged to another position. Its position can be 
changed only by means of its properties menu. 

Object Configuration 

Selecting some of the objects from the New Object list will open a 
configuration dialog box for defining the object’s permanent attributes 
(such as size and color). Attributes must be set before an object can be 
placed in a cell. 

An object’s configuration cannot be changed once the object has been 
placed in the cell. You must delete the original object, and select and 
configure the object again from the New Object list. 

Objects that have configuration options are described later in this section. 

Object Properties Menu 

Double clicking on an object that has already been placed in the cell opens 
the Object Properties menu. 

Object properties can be changed at any time during cell setup. 

All Object Properties menus contain the object’s name and the following 
options. Some objects have additional properties which are described in 
the individual sections. 

Rename Every object is automatically assigned a name 
and a number when it is placed in the cell. This 
name is displayed in the object’s properties menu. 
The number indicates the order in which objects 
of the same type were added to the cell (e.g., 
FEEDER1, GFEEDER2). 

Clicking on Rename opens a dialog box that 
allows you to change the name of the object. The 
number can be changed or deleted. 
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Rotate Objects can be rotated to any degree, in the minus 
(clockwise) or plus (counterclockwise) direction. 

Clicking on Rotate opens a dialog box that allows 
you to change the object’s orientation. 

The degree of rotation is always defined relative 
to the object's default (predefined) orientation. 

Position The cell has a point of origin at table level 
defined by XY coordinates (0,0). All object 
positions are defined in XY coordinates relative 
to this point of origin. 

For most objects these XY coordinates indicate 
the center of the object’s base. 

By default, the robot is placed in the cell with the 
center of its base (i.e., the robot's point of origin) 
at the cell’s point of origin. 

Clicking on Set Position opens a dialog box that 
allows you to change an object’s X and/or Y 
coordinates. 

Show Text Shows/hides the label for the selected object. 

This option can only be activated when View | 
Object Names or View | Object Positions is 
selected. 



 

New Objects Menu 

 

New objects are added to the cell using the New Objects 
menu. The objects are arranged in groups (robots, peripheral 
axes, etc.). 

To add a new object to the cell, click on the desired object 
group (folder) and then select the specific object. The groups 
are detailed below. 

Robots 

The robot, which is automatically placed at the cell’s point of origin, 
should be the first object you place in the cell. 

The robot cannot be dragged to a new location. Its position can be changed 
only by means of the robot’s Properties menu (see Object Properties 
Menu, on page 19). 

Only one robot can be placed in the cell. 

To add a robot to the cell click Robots, and Select ER 9Pro. 

Robot Configuration 

 

 

A dialog box titled ROBOT1 opens allowing you to define 
whether or not the robot is mounted on a linear slidebase (LSB), 
a peripheral device that enables linear movements of the robot 
unit. 

By default, the robot has No Slidebase and when you confirm 
this option, the robot is immediately placed in the cell. 

Alternatively, these slidebase options are available: 

 Slidebase 1.0 m, belt drive 

 Slidebase 1.8 m, belt drive 
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If you select a slidebase, the Robot Configuration dialog box 
looks like this: 

 

Figure 4-6: Robot Configuration 

Properties tab: 

LSB Height Above 
Table Top (mm) 

By default, if the robot is on a LSB with stand, 
then “LSB Height Above Table Top” is 0. 0 - it 
is a table height level. 

If the robot is on a LSB without Stand and the 
LSB is on the table, then “LSB Height Above 
Table Top” is 95 mm. 

Robot Angle (deg) By default, the robot is mounted perpendicular 
to the slidebase at 90º. 

If you select a slidebase, the robot and the slidebase are treated as one 
object in the cell. 

Peripherals tab: 

To select a controller peripheral axis that controls the slidebase (and any 
other peripheral device that has already been defined), click on the 
Peripherals tab. 
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Figure 4-7: Axis Selection for Peripherals 

Peripheral devices can be connected either to axis 7 or to axis 8. To 
connect a device listed under Not connected, click on it and drag it to one 
of the free controller axes. If you drag the device to an axis that already 
has a connected device, the new device replaces the previous device which 
is disconnected and relocated under Not connected. 

You can leave the slidebase not connected at this stage and connect it later 
using View | Controller Setup, or the Controller Setup icon. 

Robot Properties 

In addition to the standard object properties (see Object Properties Menu, 
on page 19), this option is listed as a Robot property: 

Show Envelope Displays the span of the robot’s working range. 
This option facilitates the placing of objects 
within the reach of the robot. 

Robot Setting Opens a dialog box to change pneumatic gripper 
parameters. 
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Peripheral Axes 

 

 

 

Peripheral devices include a motor with speed and position control. 
They are connected as axis 7 or axis 8 of the controller. 

To place a peripheral device in the cell, click Peripheral Axes and 
select the required device. 

If you select either of the slidebases or a linear table, you will be 
asked to define the LSB Height as described in Robot Configuration, 
Properties tab, on page 21. 

For all devices you have the opportunity of allocating the controller 
axis at this stage (see Robot Configuration, Peripherals tab, on page 
21). 

I/O Devices 

 

 

RoboCell I/O (input/output) devices can be connected to any free 
input/output terminal.  The robot controller has eight digital input 
and eight digital output connections. 

To place an I/O device in the cell, click the I/O Devices group and 
select the required device.  
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Experiment Table 

An experiment table includes the following input and output devices: 

 Four (4) touch sensors – (input device). Activated when there is a part on 
the switch, or something activates the switch. 

 Lamp – (output device). 

 Buzzer – (output device). 

 

Figure 4-8: Input/Output Devices 

When you select Experiment Table, this dialog box opens enabling you to 
define the input and output connections (see the Controller Setup option 
under View Menu, on page 15): 

 

Figure 4-9: Experiment Table Input/Output Configuration 

Although one of the experiment table inputs may be disabled if the input is 
later defined for another device, all other switches will remain connected 
to their defined inputs. 
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In RoboCell, a sound is emitted when the outputs that control the buzzer 
and lamp are turned on and off. The experiment table outputs use the 
Windows sounds associated with the following events: 

 Buzzer On: - Exclamation 

 Buzzer Off: - Critical Stop 

 Lamp On: - Asterisk 

 Lamp Off: - Information 

In addition, the lamp in the Graphic Display turns bright red when its 
associated output is turned on. 

Sensor 

RoboCell includes digital sensors that can be configured to detect specific 
objects based on their color and/or material (metal, plastic, wood, etc.). 
The objects are listed in the Materials group and their properties are 
defined when they are placed in the cell (see User Parts and Objects, on 
page 39). 

When you select Sensor, this dialog box opens enabling you to define the 
color/material to which the sensor is sensitive, as well as the sensor’s 
height. 

 

Figure 4-10: Sensor Configuration 
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Color Detect By default, the sensor is set to detect all colors. 
To set it to a specific color, uncheck All Colors. 
Click Color Detect to open a color palette from 
which you can select the required color. 

If the sensor is configured to be sensitive to All 
Colors, the sensor in the cell is colored different 
shades of gray with its upper part in white. This 
distinguishes it from a sensor configured to be 
sensitive to gray, which is entirely gray. 

Material Detect By default, the sensor is set to detect all 
materials. To set it to a specific material, uncheck 
All Materials. Select a material (Metal, Glass, 
Plastics, or Wood) from the drop-down list.  

Height (mm) Defines the height (above table level) at which 
the sensor will be placed in the cell. 

The default height is 40 mm. If you increase the 
height, the stand on which the sensor is mounted 
will appear taller. 

Storage 

 

 

The storage devices in RoboCell enable you 
to store, place and retrieve objects listed in th
Materials group. 

e 

Gravity Feeder 

The Gravity Feeder is an inclined plane on which objects are placed, one 
above the other. 
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Figure 4-11: Gravity Feeder 

Unlike most objects, the feeder’s position is defined as the point at which 
the robot takes an object from the lower part of the feeder. All the 
remaining objects slide down the feeder to be taken in turn. 

 

When placing objects on the gravity feeder, you must position them in the 
light gray section of the feeder’s mouth 
(as shown by the Cursor in Figure 4-11). 

 

Cursor 

Figure 4-12: Placing Objects in Gravity Feeder 

The feeder is fitted with a touch sensor (named NotEmpty) located at the 
lower part of the feeder. The sensor indicates when there are parts in the 
feeder, i.e., it is on when the feeder is not empty. 
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Feeder (Pneumatic Feeder) 

The (pneumatic) feeder is constructed from a magazine of objects and a 
pneumatic cylinder fitted at the lower section. 

The feeder is also fitted with a touch sensor that is pressed (the input is on) 
when there are parts in the feeder (NotEmpty sensor) 

The pneumatic cylinder is controlled via a controller output. When the 
output is turned on, the piston extends, pushing out the next object. 

The robot picks the objects from the feeder output tray, and the feeder 
position is defined as the point at which the robot takes an object from the 
feeder. 

 

Figure 4-13: Robot Position for Picking Objects 

Feeder Configuration 

Configuration for the Gravity Feeder and the Pneumatic Feeder is 
described below. The differences between the two methods are indicated. 

When you select a feeder, a configuration dialog box opens: 

 

Figure 4-14: Gravity Feeder Configuration 
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Properties tab: 

Number of Parts in 
Feeder 

Defines the number of parts that are loaded in 
the feeder at the start of operation (when the cell 
is opened or reset). Only one material object 
(e.g., cylinder, cube) should be placed in a parts 
feeder. The software multiplies the object by the 
number of parts specified. Default: 0 

Height at Front of 
Feeder (Gravity 
Feeder only) 

Defines the height of the lower part of the feeder 
above the table level. Default: 200 

Height at Back of 
Feeder (Gravity 
Feeder only) 

Defines the height of the higher part of the 
feeder above the table level. Default: 280 

 

Inputs tab: 

To define the robot controller input to which the feeder’s NotEmpty sensor 
is connected, click on the Inputs tab. 

Outputs tab: (Pneumatic Feeder only) 

To define the robot controller output to which the feeder is connected, 
click on the Outputs tab. A new part appears in the feeder when the output 
is turned on. 

Feeder Properties 

In addition to the standard object properties (see Object Properties Menu, 
on page 19), this option is also listed in the Feeder Properties menu: 

Capacity Enables you to alter the number of parts loaded in 
the feeder after the feeder has been configured. 

 

Jig, Rack, Template, Buffers, ASRS and Bin 

No settings are required for these storage devices. Double click on the 
desired device and place them in the cell at the desired location. 



Machines 

 

The Machines group includes two Mills (Mill, PLM1000) and two 
Lathes (Lathe, PLT3000). A CNC controller controls these machines. 
The robot controller and the machine controller communicate through 
inputs and outputs. The machine output is the controller input, and vice 
versa. 

All these machines are configured in the same way. 

When you select any of these machines, a configuration dialog box opens: 

 

Figure 4-15: Machine Configuration 
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Properties tab: 

Controller Output 
for Doors 

Specifies whether or not the machine doors 
are controlled by the robot controller output. 
If the doors operate independently of the 
robot controller, they open and close at the 
beginning and end of the machine cycle. 

Cycle time 
(seconds) 

Sets the amount of time (in seconds) of the 
machine process. Default: 10.  

Inputs tab: 

Controller input 
(machine output) 

The machine informs the controller that a 
process is being carried out, i.e., when the 
input is on, the machine is busy.  

Outputs tab: 

Controller output 
(machine input) 

Closes and opens the machine door. The 
machine cannot start if the door is open.  

Controller output 
(machine input) 

Closes and opens the machine chuck. The 
chuck holds the object during the process. 

Controller output 
(machine input) 

Sets the robot controller output to which the 
machine is connected. The machine cycle 
starts when the output is turned on. 

To modify the configuration after the machine has been placed in the cell, 
double-click on the machine to open its Object Properties menu (see 
Object Properties Menu, on page 19). Select Machine Setting to open the 
Configuration dialog box. 



Welding Tools 

 

The Welding Tools group includes: 

 Welding Table 

 Welding Machine 

 Gun Stand 

 Welding Jig A 

 Welding Jig B 

Full details on use of the welding tools are provided in Chapter 7, 
Welding Features. 

 

Welding Table The welding table holds the welding object and it 
should be placed in the cell just before or after the 
robot (the first object) has been placed. Most 
welding objects are automatically placed at the 
correct default welding table height, even if they 
are not placed directly on the welding table. 

Welding Machine The welding machine supplies the electrical 
power required to weld the materials. It is 
connected to the welding gun by a cable. You 
cannot save a cell containing only a welding gun 
or only a welding machine. Neither or both must 
be present in order to save the cell. 

Gun Stand The gun stand holds the welding gun between 
welding sessions. The robot picks the gun from 
the stand before starting the weld, and returns it 
to the stand when the welding is finished.  

Welding Jig A Welding Jig A is a device used to securely hold 
two materials being welded together in a T-joint.  

Welding Jig B Welding Jig B can be used for various types of 
welds. 
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Welding Materials 

 

The Welding Materials group includes the plate and the metal cube. 

Usage of the welding materials is detailed in Chapter 7, Welding 
Features, on page 57. 

Plate 38 x 2 x 89 

Plate refers to the welding metal plates which are used with Welding Jig 
A. When you select Plate, this dialog box opens: 

 

Figure 4-16: Welding Plate Configuration 

Colors You can define the color of the plate to which the 
sensor is sensitive. The default color is blue. To 
change the color, click Colors. This opens a color 
palette from which you can select the required 
color. Make sure the color you select is 
compatible with the sensor’s detection definition. 

Size The default dimensions of the plates are 38 x 89 x 
2 mm. These are for display purposes only and 
cannot be changed. 
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Metal Cube 

When you select Metal Cube, this dialog box opens: 

 

Figure 4-17: Metal Cube Configuration 

Colors Define the color of the cube in the same way as 
described for the Plate. 

Size The default dimensions of the cube are: 300 x 100 
x 4 mm, which you can modify if desired. 

General 

 

The General group includes a table and a computer (which is for 
display purposes only). 
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Table 

It is a good idea to place the table in the cell just before or after the robot 
has been placed. It is also recommended that you place one or more tables 
in the cell so that objects do not float in space or lie on the floor. Most 
objects will be displayed at the correct height, even if they are not sitting 
on tables. 

When you select Table, this dialog box opens: 

 

Figure 4-18: Table Configuration 

Colors To change the color, click Colors. This opens a 
color palette from which you can select the 
required color. 

Size Defines the width and length of the table. X and 
Y dimensions are always in accordance with the 
X and Y dimensions of the cell. (Use the View | 
Scene Origin option to display the X and Y 
dimensions of the cell.) 
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Materials 

 

The Materials group includes objects that can be manipulated by the 
robot: 

 Cube 

 Cylinder 

 Ball 

 User defined parts (see User Parts and Objects, on page 39) 

You can place as many objects as needed. 

Cube/Cylinder/Ball 

When you select Cube/Cylinder/Ball, the Object Configuration dialog box 
opens: 

 

Figure 4-19: Cube Configuration 

Colors You can define the color of the plate to which the 
sensor is sensitive. The default color is red. To 
change the color, click Colors. This opens a color 
palette from which you can select the required 
color. Make sure the color you select is 
compatible with the sensor’s detection definition. 

Object Material The cell sensor can differentiate between 
different materials. The default material is plastic. 
Other available materials are glass, metal and 
wood.  When metal is selected, you can perform 
welding using the features described in Chapter 7, 
Welding Features.  
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Size (mm) 
Cube: X, Y, Z 
Cylinder: Diameter, 
Height 
Ball: Diameter 

The default dimensions of the objects can be 
modified if desired. 

  

Horizontal/Vertical 
(for Cylinder only) 

Defines whether the cylinder is placed in a 
horizontal or vertical position. Cylinders that are 
placed in the lathe should be defined as 
horizontal. 

User Parts and Objects 

 

To insert a part or an object, select the desired part/object from the 
Materials/User Objects group. 

Point and click on the location where you want to place the part/object. 
You may need to wait a moment for the cursor to appear. Do not double 
click. 

 

Parts 

Parts are basic shapes that can be used to simulate any type of material the 
user chooses. Simply click on Part 1, 2 or 3 to add a new part to the cell. 

In RoboCell, parts are changed to show what they look like at the end of 
the mill or lathe machining process. You may design your own finished 
parts. 

User parts are stored as files in RWX format. The robot and machines can 
manipulate these objects. User part files are saved as PART*_0.RWX 
(where * represents 1, 2, or 3), and finished parts are named 
PART*_1.RWX. The files are located in the C:\Intelitek\RoboCell-
PRO\BIN\resource\ folder. This is the default resource folder location. 

Objects 

The objects included in the User Objects group are for illustration 
purposes only. User Object files are named USER*.RWX. The files are 
located in the C:\Intelitek\RoboCell-PRO\BIN\resource\ folder. This is the 
default resource folder location.. 
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Advanced users who know how to create 3D objects in RWX format can 
design and use such objects in the robotic cell. No more than three user-
defined parts and eight user objects may be used at one time. For further 
directions on designing user parts/objects, see Designing User Parts and 
Objects, on page 40. 

Designing User Parts and Objects 

Modify an Existing User Part File 

You may change the existing user part to create your own user part. To 
modify an existing user part, do the following: 

4. Open the C:\Intelitek\RoboCell-PRO\BIN\resource folder. This is the 
default resource folder location. The files are located in the 
SBWSIMn RESOURCE folder.. 

1. Using a text editor that saves files in plain ASCII format, such as 
Notepad, open one of the existing user part files (PART1_0.RWX, 
PART2_0.RWX or PART3_0.RWX). The file looks like the following 
example: 

  ModelBegin 

    TransformBegin 

    Color 0.0 1.0 1.0 

    Surface 0.4 0.3 0.2 

    Opacity 1.000000 

    LightSampling Facet 

    GeometrySampling Solid 

    TextureModes Lit 

    Texture NULL 

    ClumpBegin 

          Translate 0.0 0.0251 0.0 

      Tag 1 

      Block 0.05 0.05 0.05 

                    ClumpBegin 

                    Tag 2001 

                    Color 1 0 0 

                    Opacity 1 

                    Block 0.03 0.02 0.07 

                    ClumpEnd  

   TransformEnd 

  ModelEnd 

2. Edit the file to create your own part. 
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3. Save the file. Since you can only have three user part files at a time, 
you must replace the original file. Do not change the file name. 

4. To create your own finished part, edit the Part*_1 file. 

If you do not want to create a finished part, delete the Part*_1 file. 

Create a New Part/Object File 

If you can create your own user part and user object files, do the 
following: 

1. Open a text editor that saves files in plain ASCII text, such as 
Notepad. 

2. Write the program to create your own part. 

3. Save as file type .RWX. (You must name the file PART1_0.RWX, 
PART2_0.RWX, or PART3_0.RWX.) 

4. To create a finished part, name the file PART*_1.RWX. There must 
also be a PART*_0.RWX file to go with it (i.e., in order for there to be 
a PART1_1 file there must be a PART1_0.RWX file). 

5. Copy the files to the SBWSIMn\RESOURCE folder. 

Note: It is recommended that you do not discard the original files 
supplied with RoboCell. Save the original files under different file 
names.  

6. To create a User Object, follow the above steps and name the file 
USER*.RWX.  USER*.RWX files cannot be manipulated by the robot 
or machines. You must replace the original user object files. 

Import a CAD File 

You can create a 3D object in a CAD program, and import it to RoboCell. 
To import a CAD file do the following: 

1. Create a file in any CAD program. Save as *.DXF or *.3DC. 

2. Use the DXFtoRWX, or 3DCto RWX converter to convert the file to 
RWX format. 

3. Name the files PART1_0.RWX, PART2_0.RWX, or Part3_0.RWX. 

4. To create a finished part, name the file PART*_1.RWX. There must 
also be a PART*_0.RWX file to go with it (i.e., in order for there to be 
a PART1_1.RWX file there must be a PART1_0.RWX file). 

5. Copy the file to the SBWSIMn\RESOURCE folder.  

To import a user object, follow the above steps and name the file 
USER*.RWX. 

For more information on RWX files, consult a manual on RWX 
programming. 





 

5 
Working in RoboCell 

RoboCell integrates the SCORBASE robotic software with a graphic 
display module, which allows you to define (teach) robot positions and 
execute robot programs in a virtual robotic workcell. 

RoboCell’s user interface and menus are similar to those of SCORBASE. 
The main differences are detailed in this chapter. They include: 

 The graphic module, which enables position definition and 
SCORBASE program execution in a virtual or real workcell. 

 Additional options which facilitate the integration of SCORBASE in 
RoboCell appear in RoboCell menus. 

All SCORBASE operations, menu items and programming language are 
described in the SCORBASE User Manual. 

RoboCell Menus 

When you open Robocell and select New Project, this window appears: 

 

Figure 5-1: New Project Window 
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File Menu 

 

The following options are available from the File menu: 

 

New Project Opens a new untitled project (see Figure 5-1). 

The new untitled project does not include a 
robotic workcell (3D window). 

To add a workcell, do one of the following: 

 Select File | Import 3D model to open an 
existing workcell file. 

 Select File | Edit 3D model to open CellSetup 
and create a new workcell.  

 

Open Project Opens the Load Project window which lists 
SCORBASE files (without a virtual cell), and 
RoboCell files (that include a virtual cell). 

 

Save Project Saves the project (program, positions and 
graphics). 

 Save Project as…. Saves the project (program, positions and 
graphics) under a different name. 

 Print Program Prints the SCORBASE program. 

 Print Positions Prints the positions defined by the user. 

 Print 3D image Prints the graphic cell. The output is an image of 
the current cell. 

 Print Preview 
3D Image 

Opens a dialog window that shows how the 
printed cell will appear on paper. 

 Print Charts Opens a dialog box to select the chart of a 
specific axis for display or printout. Only one axis 
can be selected at a time. 
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 Print Preview Charts Opens a window that displays the chart of the 
selected axis showing how it will appear on 
paper. 

 Import 3D Model Opens the Import 3D Model window which lists 
graphic module files (*.3DC files). 

Select one of the files to open the graphic display 
module window. When you save the project, the 
current workcell is included as part of the project. 

 Edit 3D Model Opens CellSetup. If the project already includes a 
workcell, CellSetup opens that workcell for 
editing. Otherwise, CellSetup opens with a new 
untitled empty cell. 

 

 View File Opens the View File window which lists the 
following files: 

 Graphic module files (*.3DC) 
 SCORBASE programs (*.sbp) (Note: It is 

possible to copy and paste an sbp file into 
your own project.) 

 Position data (*.pnt) 

When you select a file, a window opens 
displaying that file. 

 Exit Closes RoboCell. 

Edit Menu 

The Edit menu is identical to the SCORBASE menu, which is used to edit 
SCORBASE programs. See the SCORBASE User Manual (or Help file) 
for a description of this menu’s options. 

Run Menu 

The Run menu is identical to the SCORBASE menu whose options allow 
you to run the SCORBASE programs and send the robot home. 

If you select Options | Simulation, running a SCORBASE program will 
run the robot in the virtual cell. 

If you select Options | On-Line (and a robot connected to the computer) 
the virtual and real robot will work together. 
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Options Menu 

The Options menu is similar to the SCORBASE menu. The only 
difference is the Simulation option. When checked, the robot in the virtual 
cell will run according to the SCORBASE program instructions. See the 
SCORBASE User Manual (or Help file) for a description of this menu’s 
options. 

Note: Advanced Commands are detailed in the SCORBASE User Manual. 
The ViewFlex Commands are detailed in the ViewFlex User Manual. 

View Menu 

The View menu is identical to the SCORBASE menu whose options allow 
you to toggle the display of SCORBASE dialog bars and menus. 

3D Image Menu 

The options of this menu are described in Graphic Display Module below. 

Window Menu 

The options of the Window menu offer screen settings that enable optimal 
usage of the screen while you are carrying out various operations such as 
defining positions, programming and running the SCORBASE programs. 

Help 

RoboCell Help Opens RoboCell help. 

SCORBASE Help Opens SCORBASE help 

Scripting Help Opens Visual Basic Script help. 

About…  Shows RoboCell version. 

Registration… Opens the Software License window for registration  
 and for transferring the RoboCell license to another computer. (See 
Chapter 11 for further information.)  

Graphic Display Module 

The graphic module file is an integral part of a RoboCell project. Opening 
or saving a project opens or saves the RoboCell program, robot positions 
and graphic module data as one entity. 



 

You can open a new RoboCell project and then import a virtual cell from 
an existing project or a cell created using CellSetup (File | Import 3D 
Model). 

Only one CellSetup file/window can be opened at a time. 

When you open a project which already contains a workcell, the graphic 
display module window appears. The window is titled 3D image and the 
project name. 

 

Figure 5-2: 3D Image Window 

The 3D image portrays the robotic workcell and all its components. Using 
the graphic display tools described in Chapter 3, you can manipulate the 
image and view it from different angles by controlling the angle and 
position of the virtual “camera” that monitors the workcell. Other tools 
enable you to see other data related to the cell (such as object name, 
position or the number of part in a feeder). 

3D Image Menu & Toolbar 

All graphic display tools are accessible from the 3D Image Menu. 
Frequently used tools can also be accessed from the toolbar.  

 

Reset 3D Model Returns the workcell image to the initial setting 
and position (saved in CellSetup). 

This tool is useful when you want to initialize the 
workcell before re-running a program. 

 
Top View Resets camera position to the top center point of 

the cell. 
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Drag Image Activates the drag mode in order to drag the entire 

image to a new position. 

Using the cursor, point and click anywhere on the 
image and drag it to its new position. The drag 
mode remains in effect until you select another 
option or press [Esc].  

 Camera Sub-options: The 3D image window displays the output of a 
virtual camera that is fitted in the workcell. 
Manipulating the camera determines how the 
image is displayed in the window.  

 
Redirect Camera Selects the point that will always be in the center 

of the screen (while rotating, zooming and 
changing the camera’s angle). 

The Redirect Camera mode remains in effect until 
you select another option or press [Esc]. 

 
Follow me Camera Enables you to follow the movement of any object 

(robot gripper, certain object, etc.) when the 
workcell is running. 

To select the point, choose a point on a moving 
object (part of the robot or an object). 

Press [Esc] to exit Redirect Camera. 

 

Save Camera Position Saves the current camera position. Only one 
camera position can be saved. Saving a new 
position overwrites the previously saved position. 

 Restore Camera 
Position 

Restores the position recorded using Save Camera 
Position. 

 

 

 Labels Sub-options:  

 

Object Names Shows/hides Object Name labels. 

 
Object Positions Shows/hides Object Position labels. 

The label displays the X and Y coordinates of the 
object position that is relative to the coordinates of
the 3D model. 

 Object Positions in 
Robot Coordinates 

Shows/hides Object Position Robot Coordinates. 
The object position displayed is relative to the 
robot coordinates. The robot coordinates may be 
different from cell coordinates if: 
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 The robot was moved after initial setting (in 
CellSetup) 

 The robot is equipped with LSB. When the 
robot moves, the position of objects relative to 
the robot changes. 

 Number Parts in 
Feeder 

Shows/hides a label that displays the number of 
remaining objects in a feeder. 

 Send Robot Sub-
options 

Select Options | Simulation to enable the Send 
Robot options. 

 
Send Robot to 
Object 

Sends the robot to the selected object. 

Make sure the gripper is open before sending the 
robot to the object. 
This option is useful for defining a robot pick 
position. 

 
Send Robot to 
Point 

Sends the robot to the selected point. This option 
is useful for defining a robot place position. 

 
Send Robot to 
Above Point 

Sends the robot to a point above the selected point 
on the table. 

Default: point 100 mm above the selected point. 

 Options for 
Send Robot 

Opens the Send Robot Options dialog box 
enabling you to define the vertical offset values 
and the gripper’s orientation when Send Robot 
commands are executed. 

 

Figure 5-3: Send Robot Options 

The settings remain in effect for all subsequent Send Robot commands. 
When the gun is selected, default gun settings are used automatically; 
user-defined settings are ignored. 

By default, the robot moves to an object or point with the gripper 
perpendicular (-90) to the table and with no (0) rotation. 
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You may also use the SCORBASE Manual Movement dialog box (see 
Robot Manual Manipulation, on page 51) to adjust the orientation (pitch 
and roll) of the gripper. You can then select the option Use Current to 
maintain the gripper’s orientation during subsequent Send Robot 
commands. 

The Z-offset value is used by the Send Robot to Object and Send Robot to 
Point commands. The Z-offset Above Point value is used by the Send 
Robot Above Point command. 

Show Path When selected, a line showing the gripper path is drawn 
on the screen as the robot moves. The distance between 
the points is proportional to the TCP speed. 

Clear Path Clears the robot path that was drawn using Show Path.  

Show Origin Shows the origin of the cell at floor level (under the 
center of the robot’s base) as a red cross marked with X 
and Y axes. The positions of all objects are defined as 
relative to this point of origin. When manipulating the 
graphic display, the cross may disappear momentarily. 
This option is the same as Scene Origin described in 
Chapter 4, CellSetup. 

Show Robot Work 
Envelope 

Displays the span of the robot’s working range allowing 
you to see whether objects are within the reach of the 
robot. This option is the same as the Show Envelope 
option of the Robot Properties. 

Welding Settings Opens the Welding Setting dialog box, which enables 
definition of the welding parameters (see Figure 7-7). 



 

6 
Cell Operation 

Operating and programming the robot in RoboCell is similar to working 
with a hardware robot. Graphic display features and automatic operations, 
such as Cell Reset and Send Robot commands, enable quick and accurate 
programming. 

Robot Manual Manipulation 

The SCORBASE Manual Movement dialog box allows you to manipulate 
the robot and peripheral axes in the simulated cell in the same way that it 
provides control of an actual robotic system. 

 

Figure 6-1: Manual Movement Dialog Box 

Clicking with the mouse on the keys on the Manual Movement dialog box 
keys, or pressing keys on the keyboard, moves the virtual robot axes. 
Movement of an axis continues as long as the button or key is pressed, or 
until a software or hardware limit is reached. 

Note: Axis 6 is disabled for robot configuration with pneumatic gripper. 

Use the Open Gripper and Close Gripper buttons to control the gripper. 
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Machine Operation 

You can operate the Mill or Lathe directly from the Digital Output dialog 
box, or with program commands (see Program Execution, on page 56). A 
program continues to run after the machine begins to operate. 

Be sure to close the chuck on the Mill or Lathe before you open the Robot 
gripper to release it. A part placed in the Lathe will drop to the bottom 
unless the chuck is closed before opening the robot gripper. 

A part placed in the Mill may fall once the Mill cycle begins, if the chuck 
is not closed before starting the cycle. 

Mill and Lathe will work only if the door is closed. 

Send Robot Commands 

Send Robot commands can often be used instead of the SCORBASE 
Manual Movement dialog box. Commonly, however, you will use the 
Manual Movement dialog box to adjust the robot’s position after using a 
Send Robot command. 

When SCORBASE is operating online with an actual robotic cell, the 
Send Robot commands and options are disabled. 

When using the Send Robot commands, be aware of certain characteristics 
of the following objects. 

Feeders Click on the part in the feeder (and not the feeder 
itself), to select it as the target position for the 
Send Robot to Object command. 

To easily pick up a part from the feeder, select a 
pitch of 0° and a roll of (-90°) in the Send Robot 
Options dialog box. 

Lathe Each of the four clamps in the chuck can be a 
target object. You cannot use the Send Robot to 
Object command to place an object in the lathe. 
Object must be placed in the chuck manually. 

Only cylinders can be placed in the chuck. Use 
the Manual Movement dialog box to position the 
cylinder exactly.  

Mill Click on the jig in the mill to select it as the target 
for the Send Robot to Point command. Use the 
grid on the jig to help place the object. 
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Table Use the Send Robot to Point (not Send Robot to 
Object) command and select a specific target 
point on the table. The robot moves to that 
position with the offset defined in the Options for 
Send Robot dialog box. 

Template Although it is regarded as one object, the 
template is comprised of two objects, the tray and 
the handle, either of which can be a target object. 
The template has only one position, defined by 
the center of the tray. 

Use Z-offset 35 mm to send the robot to the 
template tray. 

Use Z-offset 0 mm (user-defined) to send the 
robot to the template handle. 

 

 
 

Gripper 

Grasping Objects 

The robot gripper in RoboCell will grasp an object only as a result of 
Close Gripper commands. 

When the gripper closes on an object, the object is pushed into the center 
of gripper. 

In addition, cubes and horizontal cylinders are rotated into alignment with 
the gripper jaws, provided the rotation offset does not exceed 35º. When 
the offset is about 45º, the gripper simply grasps the object at its corners. 

Since objects are rotated around their center, a long object that will be 
grasped far from its center must be aligned with the gripper as much as 
possible before the gripper is closed. 

Releasing Objects 

RoboCell operates in a gravitational field. Objects that are released from 
the gripper will fall to the first surface below them. 

If more than half of an object’s base rests on a surface, the object will 
remain on the surface. Otherwise it will fall onto the surface below. 

Objects can be picked up and released at any rotation. 
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Impact Detection 

RoboCell checks for the following impact conditions: 

 The tip of the gripper hits an object or the robot itself. 

 The edge of the gripper motor (mounted on top of the gripper) hits an 
object or the robot itself. 

 An object held by the gripper hits another object or the robot. 

RoboCell’s impact error message is the same one sent by SCORBASE 
when an actual robot cannot reach a target position. Since there are no 
mechanical (motor) or electrical (encoder) failures in simulation, you can 
assume simply that the gripper or an object held by the gripper has 
collided with the robot or another object. 

The Graphic Display status line indicates the object on which the impact 
has occurred. 

In response to the impact error message, select OK to resume Control On. 
Then move the robot away from the impact condition. If a Send Robot 
command caused the impact, the robot will resume movement from the 
position that preceded the Send Robot command. 

When SCORBASE is operating online with an actual robotic cell, 
SCORBASE controls impact detection and response, and Cell 
Simulation’s impact detection function is disabled. 

Defining Positions 

RoboCell provides the methods described below for defining robot 
positions. A position is identified by its assigned number. 

Recording Position #1 

1. Use the SCORBASE Manual Movement dialog box to manipulate the 
virtual robot in the same manner in which you would manipulate an 
actual robot. 

2. When the position is reached, type a number in the position number 
field in the Teach Position (Simple) dialog box. 

3. Click Record.  

If the position number has been used previously, the new position will 
overwrite the previous position data. 



 

Recording Position #2 

1. To send a robot to a required position, use the Send Robot to 
Object/Position/Above Position tools. 

2. If needed, use the Manual Movement dialog box for fine-tuning. 

3. When the position is reached, type a number in the position number 
field in the Teach Position (Simple) dialog box. 

4. Click Record.  

If the position number has been used previously, the new position will 
overwrite the previous position data. 

Teaching Position 

1. In the Graphic Display window, select View | Object Positions to see 
the X and Y coordinates of an object. 

2. Zoom in on the object or point whose coordinates you want to record. 

3. Click the Teach Position (Simple) Expanded button to open the Teach 
Position dialog box. 

 

Figure 6-2: Teach Positions Dialog Box (Expanded) 

4. Type the position coordinates in the X, Y, Z, P, and R fields. 

5. Enter a number in the position number field. 

6. Click Teach.  

Note: If you click Record position, the current robot position is recorded 
(and not the position defined by the coordinates you entered in the X, Y, 
Z, P, and R fields). 

If the position number has been used previously, the new position will 
overwrite the previous position data. 
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Fine-tuning a Position 

To modify existing positions: 

1. Click Teach Position (Simple) Expanded to open the Teach Position 
dialog box. 

2. Select the position you want to modify in the Position Number field. 

3. Click Get Position. The position data appears in the X, Y, Z, P, and R 
fields. 

4. Modify the required coordinate. 

5. Click Teach to overwrite the previous position.  

Program Execution 

Executing programs in RoboCell is the same as executing programs when 
using an actual robotic system. 

Since different cell configurations can be loaded and changed in RoboCell, 
keep in mind that positions and programs are not loaded together with 
their workcell. 

To use a workcell with its positions for a new project save the project with 
the workcell and positions under a different name, using the Save as 
option in the File menu. 

Then delete the program and write a new one (the positions and the cell 
remain unchanged). 



 

7 
Welding Features 

Introducing Welding Features 

RoboCell welding features contain 3D-solid modeling robotic welding 
options for teaching modern techniques of arc welding. 

The software features the following: 

 Welding of multiple parts both online and in simulation. 

 Accurate display and manipulation of welded parts both online and in 
simulation. 

 Single-command character generator that calculates and teaches all 
positions required for producing any text string. 

 Predefined welding cells and fully functional demonstration programs for 
simulated execution. 

A typical welding cell is shown in Figure 7-1. 

 

Figure 7-1: Welding Cell 
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Welding features enable several types of welding processes: T-joint welds, 
butt welds and the welding of letters and numerals. 

 T-joint weld: A T-joint weld is shown in Figure 7-2. 

 

Figure 7-2: T-joint weld 

 Butt weld: Weld in which the pieces are welded side-by-side. 
 

 

Figure 7-3: Butt Weld 

The workcell allows fully automatic T-joint welding operations: 

 retrieval of metal plates from gravity feeder 

 loading of parts into T-joint jig 

 retrieval of MIG gun 

 arc welding 

 returning of gun 

 unloading of weld from jig for cooling. 

Welding of a butt joint or of numerals/letters is performed similarly. 
However, for these processes, the metal sheets must be placed in the jig 
during the cell setup stage. The robot’s work envelope does not allow it to 
place and remove parts from this jig. 
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CellSetup Welding Tools 

The welding tools available in CellSetup are described below. (See also 
Chapter 4, CellSetup, on page 11.) 

Welding Tools 

Welding Table Configuration 

The welding table should be placed in the cell just before or after the robot 
(the first object) has been placed. Most welding objects are automatically 
placed at the correct default welding table height, even if they are not 
placed directly on the welding table. 

The welding table configuration dialog box contains the following options: 

 

Figure 7-4: Welding Table Configuration 

Colors Opens the color pallet to define the color of the 
welding table. The booth poles will remain 
default gray. 

To distinguish the table, use a color that is 
different from the colors used for the floor and 
background. 

X (mm); Y (mm) Defines the length and width of the table in 
millimeters. X and Y dimensions are always in 
accordance with the X and Y dimensions of the 
cell. (Use the Show Cell Origin option to display 
the X and Y origin of the cell.) 
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You can accept or change the default dimensions 
of 1200 x 800 mm, which represent the width of 
the welding booth’s table supplied with the 
Automated Welding tekLINK. 

Welding Machine Properties 

The Welding machine supplies the electric energy required for the welding 
process to the welding gun. As such, you cannot save a cell containing 
only a welding gun or only a welding machine. Neither or both must be 
present in order to save the cell. 

To open the welding machine properties window do one of the following: 

 Select 3D Image | Welding Setting from the RoboCell main menu. 
Note: The Welding Setting option is only enabled if you have defined a 
welding machine and a welding gun in the cell. 

 Double click on the welding machine image in the 3D window. 

 

Figure 7-5: Welding Machine Image 
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The welding machine Properties menu contains the following additional 
option: 

Welding Settings Opens the Welding Settings dialog box (see 
Figure 7-6) which enables definition of the 
following weld parameters: 

 Voltage Tap 

 Wire Diameter 

 Wire Speed 

 Shielding Gas 
 

 

Figure 7-6: Welding Settings Dialog Box 
 

Voltage Tap Sets welding machine voltage output supplied to 
the welding gun, an important variable in 
determining the quality and appearance of a weld. 
The voltage tap value is a reference number (and 
2 does not indicate a voltage value). 

The voltage tap should be set according to several 
factors, such as robot speed, wire speed and metal 
thickness. 

Wire Diameter Sets diameter of the welding wire being fed to the 
MIG welding gun. Cannot be changed. 

Default of wire diameter used in the AMT 
tekLINK is 0.023 inch. 

Wire Speed Sets speed at which the wire is fed to the MIG 
welding gun. Also known as feed rate. 

 

The wire speed setting is essentially a reference 
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value to the controller built into the welder. Valid 
values: 10 - 100. 

The wire speed is automatically regulated by the 
welder for optimal performance and does not 
need manual input. The welder determines the 
feed rate setting by weighing three factors: type 
of shielding gas, metal thickness and wire 
diameter. 

Shielding Gas Sets type of gas for shielding the weld from 
oxidation, which causes rust and poor joining of 
the welded pieces. The system only works with 
CO2 gas. 

The default parameters are set according to the Millermatic 
recommended settings (see Millermatic User’s Manual). 

Some parameters are interrelated. For example, changing the voltage tap 
causes the wire speed default to change automatically. Note that the 
wire speed can also be changed independently of the voltage tap. 

Welding settings can also be changed by the user when working within 
the Graphic Display window. The settings will remain in effect for all 
subsequent simulated welds. 

Note: Changes in this dialog box do not affect the actual Millermatic 
welder settings. 

This dialog box can also be accessed by double-clicking on the welding 
machine knobs. Note that parameter changes are reflected in the knobs’ 
positions. 

 
Controller Output 
Number for Welding 
Machine 

The welding machine operation is controlled 
using a controller output. After placing the 
welding machine (in CellSetup) you should 
assign a free controller output for controlling the 
welding machine. 

 



 

Gun Stand 

The gun stand does not require the user to define any additional 
configurations or properties. The user need only place it in an accessible 
position on the welding table. CellSetup draws the cable that connects the 
welding machine to the gun. 

 

Figure 7-7: Gun Stand 

You cannot save a cell containing only a welding gun or only a welder. 
Neither or both must be present in order to save the cell. 

Welding Jig A (T-Joint) 

Welding Jig A is a device used to securely hold two materials being 
welded together in a T-joint. This jig does not require the user to define 
any additional configurations or properties. The user need only place it in 
a position on the welding table in which the robot can access the jig from 
both ends to place and remove parts. 

 

Figure 7-8: Welding Jig A 
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Welding Jig B 

Welding Jig B can be used for various types of welds. The grooved area in 
the center of the jig can be used to securely hold two metal sheets side-by-
side to create a butt weld. The jig can also be used to hold the larger 
nameplates used with the SCORBASE Write command. For more 
information, see the SCORBASE User Manual. 

Welding Jig B does not require the user to define any additional 
configurations or properties. The user need only place it in an accessible 
position on the welding table. 

 

Figure 7-9: Welding Jig B 
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Welding Materials 

Plate 38 x 2 x 89 

Plate refers to the welding metal plates which are used with Welding 
Jig A. When you select Plate, this dialog box opens: 

 

Figure 7-10: Welding Plate Configuration 

Colors You can define the color of the plate to which the 
sensor is sensitive. The default color is blue. To 
change the color, click Colors. This opens a color 
palette from which you can select the required 
color. Make sure the color you select is 
compatible with the sensor’s detection definition. 

Size The default dimensions of the plates are 38 x 89 x 
2 mm. These are for display purposes only and 
cannot be changed. 
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Metal Cube 

When you select Metal Cube, this dialog box opens: 

 

Figure 7-11: Metal Cube Configuration 

Colors Define the color of the cube in the same way as 
described for the Plate. 

Size The AMT tekLink uses parts whose dimensions 
are: 300 x 100 x 4 mm (default), which you can 
modify if desired. Any dimensions can be defined 
provided that the cubes are compatible with either 
welding Jig A or B.  
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Additional Welding Features 

The RoboCell’s Graphic Display includes the following features: 

Advanced Send Robot Commands 

Recording Positions for Welding Jig A 

Welding features enable easier recording of positions for Welding Jig A. 
To record the position for placing a part in the left side of the jig, use the 
Send Robot to Object option and click anywhere on the protruding parts of 
the jig (indicated by the number “1” in Figure 7-12). RoboCell will 
automatically send you to the correct position for placing the part. Note 
that this position is also used for removing the welded part from the jig. 

To place parts in the right side of the jig, click on any of the areas 
numbered “2” in Figure 7-12. 

 

Figure 7-12: Recording Positions for Welding Jig 

Recording Positions for Welding Gun 

Welding features include a built-in feature to facilitate recording the pick 
position for the welding gun. To record the position for picking the gun, 
use the Send Robot to Object option and click on the gripper adapter 
handle on the gun. RoboCell will automatically send you to the correct 
position for properly picking the gun. 
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Welding Booth Doors 

The welding booth doors can be viewed or removed by double-clicking 
anywhere on the booth. 

 

 

 

 

Figure 7-13: Welding Booth Doors Image 
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Welder 

The welder has the following built-in features: 

 

Figure 7-14: Built-in Welder Features 

Wire Spool Motion During the welding process, the wire spool turns 
just as it does in reality. 

Wire Speed, Voltage 
 and Power Switches 

The knobs on the welder accurately reflect the 
welding settings defined via the Welding Settings 
dialog box. 

Double clicking on any knob opens the dialog 
box.  

Welding Parameters 

Successful automated welding is often not the result of reliable 
technology, but of proper planning. Therefore, it is extremely important to 
work only with the optimal parameter settings defined by the 
manufacturer. The following welding parameters can be modified: 

 Parameter How to Change Parameter 

Inert Gas Shield From the Welding Settings dialog box, select either 
None or CO2. 

Voltage Tap From the Welding Settings dialog box, select one of 
the reference numbers. 
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 Parameter How to Change Parameter 

Wire Feed Rate From the Welding Settings dialog box, select one of 
the reference numbers. 

Automatically changes when voltage tap is 
changed. 

Rate of Travel To define the rate of travel (the speed of the robot 
and the welding gun in the welding procedure), use 
the Duration setting in the Go To position dialog 
box. 

By changing the duration it takes to get from 
position A (weld start position) to B (weld end 
position), the robot’s speed is changed – thus 
changing the speed at which it will weld. 

Distance of Electrode 
from Materials to be 
Welded 

When recording the start/finish welding positions, 
you define this distance by defining the positions’ Z 
value. 

Welding only occurs when the electrode of the 
welding gun is located at a proper distance above 
“weldable” material. This feature was built-in to 
enable more accurate recording of the start welding 
position. 

Once the software recognizes that welding is 
“allowed”, the gun emits wire that creates a seam 
between the two materials. 

Welding will not occur in the following situations: 

 The electrode of the welding gun is too close or 
too far from the material. 

 The welding gun is located above a material 
that the software recognizes as “non-weldable”. 

Angle of electrode When recording the start/finish weld positions, you 
define this angle by defining the positions’ pitch. 

 



 

Welding Process 

Welding Gun Operation 

As welding occurs, sparks will fly from the welding gun, as shown in the 
figure below. 

 

Figure 7-15: Sparks from Welding Operation 

Weld Temperature 

Changes in the temperature of the welding seam can also be seen by 
zooming in on it during and after the welding. Immediately after the 
welding, the seam is red and yellow – indicating that it is extremely hot. 
Slowly, it changes to a grayish color – indicating that it has cooled. 

Welded Part 

After the welding process is completed, RoboCell regards the two metal 
pieces as one. 

 

Figure 7-16: Completed T-joint Welding Process 
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Weld Analysis 

RoboCell allows you to observe the quality of a weld at the end of the 
welding process. Depending on the welding settings used to create the 
weld, the appearances of welds may differ. 

After welding two metals together, double-click on the seam to open the 
Weld Properties window. 

 

Figure 7-17: Weld Properties Window 

The window displays the following information: 

 Status of the weld (i.e., good, bad, etc.) 

 Whether shielding gas was used or not. 

 Selected voltage tap value. 

 Wire diameter used. 

 Wire speed reference value that was used. 

 Speed of the welding gun. 
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8 
Replicating Real and 

Simulated Cells 
RoboCell’s representation of robot and devices are based on actual 
dimensions and functions of SCORBOT equipment. Thus, programming 
performed in RoboCell can be used with an actual robotic installation. 

From Simulation to Real 

Using CellSetup and Cell Simulation, create a cell, record all positions to 
be used by the SCORBASE program, write the SCORBASE program and 
verify program execution. 

Then, to construct an actual robotic installation that duplicates the 
simulated cell: 

1. Using CellSetup as a guide, place all objects and devices in their 
approximate locations. 

2. To print a 3D Image, select File | Print 3D Image. 

3. If necessary, hide some labels and/or change the angle and zoom of the 
camera, and print several cell maps. 

4. Consider your SCORBASE program and determine which of the 
recorded positions must be precise; for example, the point at which the 
robot takes an object from a feeder, or the point at which the robot 
places a part in a machine. 

5. In SCORBASE On-Line mode, send the robot to these key positions. 
Adjust the location and orientation of the actual objects and devices 
(e.g., feeder, machine) according to the location of the gripper.  

If you are unable to relocate the object or device, you can rerecord the 
position coordinates. 
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From Real to Simulation 

To create a simulated cell based on an actual installation, you will need to 
know the exact location and orientation of every element in the cell. 

If the cell layout is simple, this information can be obtained through a 
coordinate grid or a ruler. For a more complex cell layout, you will 
probably need a technical drawing (e.g., AutoCAD) which shows the 
center point and orientation of all objects. 

All measurements should be made with both the robot and the cell at the 
same point of origin and with the same orientation. 
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9 
Sample RoboCell Projects 

Your RoboCell package contains a number of sample projects to help 
familiarize you with the capabilities of RoboCell. These are accessible by 
means of the File Open command. Press [ctrl]-O on your keyboard, select 
Open Project from the File menu, or click on the Open icon in the toolbar. 
You will be shown a listing of all the *.WS files in the following 
subdirectory: 

C:\Intelitek\RoboCell-PRO\Projects\ER9ub 

3D Project Descriptions 

ER9Cell1 

Builds two towers, one of cylinders and one of rectangular blocks. 
Demonstrates the use of numbered positions. 

ER9Cell2 

Builds two towers from parts supplied by parts feeders. Demonstrates the 
use of named variables for positions. 

ER9Cell3 

Part sorting. Demonstrates the control of inputs and outputs. 

ER9Cell4 

Order cylinders and process parts. Demonstrates complex PICK 
movements and program control using IF statements. 

ER9Cell5 

Lathe and mill tending. Demonstrates complex operation involving robotic 
arm mounted on slidebase, two parts feeders, a lathe, a mill and various 
input/output functions. 
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ER9Cell6 

Similar to ER4Cell5, using the Intelitek ProLight lathe and mill. 
Demonstrates visual representations of the path taken by the TCP (Tool 
Center Point). 

Butt Joint 

Picks up welding tool to weld two parts in a butt joint. 

Excel_EX1 

Demonstrates the use of VBScript to transfer values from SCORBASE 
into Excel spreadsheets. 

New Project 

Empty project. 

Polygon 

Demonstrates the use of VBScript to transfer values from user input to 
SCORBASE and make floating-point calculation available to 
SCORBASE. 

Script Demo 

Demonstrates the interaction between SCORBASE and VBScript. 

Serial Port 

Demonstrates using RoboCell to send text messages via serial 
communications port. 

Tjoint 

Demonstrates complex pick & place movements and control of welding 
tool. 
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10 
Troubleshooting 

 Problem Solution 

 Installation not 
successful. 

Make sure all applications, including anti-virus monitors and 
network drivers, are closed. Then try installing the software 
again.  

 Program not 
responding 
correctly. 

There may be a message box hidden behind the application 
window. Minimize the application windows to check for 
messages or prompts. 

 Robot cannot be 
dragged to another 
position. 

By default, the robot is placed at the cell's point of origin to 
simplify the teaching of positions. 

The robot’s position can be changed only by means of its 
Properties menu. 

 Screen layout is 
jumbled or 
crowded. 

Use the SCORBASE View | Simulation & Teach or View | 
Simulation & Run to reset the screen layout. 

You can also use the SCORBASE Options | Load User Screen to 
reset a screen layout that you set and saved previously. 

 Peripheral axes 
do not move in 
RoboCell. 

When SCORBASE is operating on-line, the peripheral settings 
defined in the CellSetup file are not loaded; the peripheral setup 
defined in SCORBASE is retained. Simulated peripheral axes 
that do not match the SCORBASE definitions will not respond 
to SCORBASE commands in the Graphic Display. 

 



RoboCell User Manual 78 Troubleshooting 
1103        

 



 

RoboCell User Manual 79 Intelitek Software Licensing 
1103   

11 
Intelitek Software 

Licensing 
The software is protected by a licensing agreement.  

There are 2 license types: permanent and subscription (rent license). 

If you purchase a permanent license you will get a CD key from Intelitek. 

If you purchase subscription license you will get a Subscription CD key 
from Intelitek. 

If the software is installed without a license, you can use the fully 
operational software for a 14-day evaluation period. To continue using the 
software after this period it must be unlocked. 

The following sections contain detailed instructions on how to use the 
software license: 

 Register your software and receive a PC-specific unlock code for each 
license purchased. 

 Protect your license. 

 Transfer a license from one PC to another PC for permanent license type 
only. 

 Return the permanent license to Intelitek, so you can retrieve it later. 

 Frequently asked questions. 

To register your Intelitek software follow these easy steps: 

1. Install the software. 

To register the software on Windows Vista, click on the Robocell icon and 
select Run as Administrator. 

The first time you run the software, the Intelitek Software License dialog 
box appears. 



 

Figure 11-1: Registration Dialog Box 

2. Register using the method most convenient for you. We recommend 
registering online, which is automatic. 

To register a subscription license, select Subscription License, for the 
subscription CD key fields to appear. 

 

Figure 11-2: Subscription CD Key Fields 

The following descriptions of the different registration methods are 
relevant for both permanent and subscription licensing. 

The Intelitek Software License dialog box allows for three methods of 
registration: 

 Automatically from the Intelitek website 

 By E-mail 
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 Manual Unlock 

Automatically from the Intelitek website.  

Note: You must have internet access available on the host PC. 

1. In the Intelitek Software License dialog box, select Online. Enter your 
CD key in the appropriate fields. Your CD key can be found on the 
back of the CD case (See Figure 11-3). It was also e-mailed to you or 
sent to your team's main contact (for FIRST teams). 

2. Click Unlock.  

The software will automatically connect to Intelitek's website. An unlock 
code will automatically be installed on your PC and a message will appear 
saying that the software is now licensed.  

By E-mail 

1. In the Intelitek Software License dialog box, select E-mail as your 
registration preference. Enter your CD key in the field below. Your 
CD key should be found on the back of your CD case (see Figure 
11-3), and was either emailed to you or sent to your team's main 
contact (for FIRST teams). 

 

Figure 11-3: CD Key 

2. If email is available on the host PC, a new email containing the 
required details will open.  
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Figure 11-4: Intelitek Software License Email 

Fill in all the requested user information, and send the message. The 
licensing service will send back an unlock code, at which point you will 
complete a manual unlock (the third registration option described below). 
This process is not automated and can take up to several days.  

3. If you have email service, but not on the same computer on which the 
software is installed, a Notepad window containing all required details 
will open. Fill in all the requested user information, and then transfer 
the text/file to your email program. Be sure you have included your PC 
specific code, and CD key in the email! 

Send to: info@intelitek.com 

Subject: Intelitek Software License 

Note: To ensure successful processing, use this exact subject line and do 
not edit the automatically generated headings in the message. You may 
add your personal information and comments into the body of the 
message. 

Once you receive the unlock code, enter it in the Registration dialog box 
and select Unlock.  

Manual Unlock 

Manual Unlock registers your software without a CD Key by matching an 
Unlock Code to your PC Specific Code. You can obtain an Unlock Code 
from Intelitek if you register by email, or directly from another user after a 
license transfer.  

1. In the Intelitek Software License dialog box, select Manual. 
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2. Enter the 8 digit alphanumeric Unlock Code in the field below. Click 
Unlock 

3. If the Unlock Code matches your PC Specific Code, your software 
will be licensed.  

This completes the software registration procedure. 

Protect your permanent license 

Every unlock code is unique. It will become invalid (and cause the 
software to stop functioning) when you change a physical component in 
your PC (e.g., hard disk, network card, CPU), format your disk, or install a 
new operating system. 

 If you want to upgrade your PC and keep your software operational, you 
must first transfer the license (unlock code) to another PC. 

 Once you have upgraded your system, reinstall the software (if 
necessary) and transfer the license back. 

If you do not have a PC available for the temporary transfer operation, 
return the license to Intelitek. You will be able to retrieve the license by 
following the standard procedure for obtaining the unlock code. 

Transfer a permanent license from one PC (source) to another PC 
(target) 

1. On the target PC install the software and get the PC-specific code from 
the Registration dialog box. 

2. On the source PC, open the Registration dialog box. Enter the PC-
specific code of the target PC and Select Transfer. The software on the 
source PC will generate a new unlock code for the target PC and will 
remove the license from the source PC. 

3. On the target PC, enter the new unlock code in the Registration dialog 
box. 

Return a permanent license to Intelitek, so you can retrieve it later 

Use this procedure when you need to remove a software license and do not 
have a target PC available. 

1. From the Registration dialog box, select Remove the License and click 
Remove. The software will generate a unique Remove code. 

2. Send the Remove code and your CD key to Intelitek using one of the 
methods described above (email, website, fax/phone). We will confirm 
the codes and update our licensing registration records. 

3. When you are ready to retrieve your license, install the software (if 
necessary) and follow the instructions for obtaining an unlock code. 

4. The installation procedure generates a PC-specific code. This code is 
found in the Registration dialog box. 
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To receive the unlock code for the software you installed, you must send 
Intelitek both the CD key and the PC-specific code. The Registration 
dialog box provides several methods for obtaining the unlock code. 
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FAQs – Frequently Asked Questions 

What is a CD key? 

This is the code on a label on the CD. It allows Intelitek to track software 
that has been purchased. 

What do I do if I do not have a CD key? 

When prompted to enter the CD key during the software installation, enter 
the word “evaluation”. This will allow you to install the software for a trial 
period. 

What is a PC-specific code? 

This is a code generated by the software. It is unique for each PC and each 
installation of the software. This code allows Intelitek to generate the 
unlock code for the PC on which you installed the software. The PC-
specific code is displayed in the Registration dialog box. 

What is an unlock code? 

This is a code that allows you to use the software after the evaluation 
period expires. You need to send your CD key and PC-specific code to 
Intelitek. We will reply with the unlock code for the software you 
purchased. 

How do I install and register the software on more than one PC? 

Repeat the procedure for obtaining an unlock code as many times as 
necessary. 

Alternately, install the software on all PCs and make a note of the PC-
specific code generated on each PC. You can then send us one email or fax 
listing all the PC-specific codes. You will receive unlock codes for each 
PC. (Note: this will be handled manually by our technical support and 
may take several days). 

Why should I give you my personal details when I request the unlock 
code? 

This will allow us to keep you informed about products, upgrades and 
services available for your system and software. It will also allow us to 
help you in case of a lost license. 

How can I recover the unlock code after a disk crash or other system 
failure? 

Once you have restored and reactivated your PC, reinstall the software. If 
it resumes operation in Evaluation mode, follow the procedure for 
obtaining an unlock code. Include a comment explaining why you need a 
new unlock code. (Note: this will be handled manually by our technical 
support and may take several days). 
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How can I extend the evaluation period? 

To continue using the software after the evaluation period has expired, 
either a subscription (rent license) or a permanent license must be 
purchased. 
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